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Introduction 
E-Z Mobile for Palm OS® is a robust custom application that E-Z Data developed for Palm OS® 
devices. Using iAnywhere Solutions’ Ultralite database and MobiLink Server, E-Z Mobile for 
Palm is used to synchronize Client Data System (CDS) with the Palm device without interfering 
with existing information. 
The following records can be synchronized: 
• Contact – Individual 
• Contact – Business 
• Calendar 
• SmartPad 
• Policies 
• Investments 

Pre-Installation Checklist 
Prior to installation, please make certain that all of the following requirements are met: 

 CDS version 6.0 or later must be installed on the system (stand-alone or workstation). 

 Verify that the Palm OS®-compatible device is running Palm OS® version 3.5.3 or higher and 
has 4MB of RAM available. For optimum performance, a processor of 33 MHz or higher is 
also recommended. 

 Synchronization in a network environment is only supported through the use of the TCP/IP 
protocol. If TCP/IP is not used as the communication protocol between the workstation and 
server, synchronization between CDS and E-Z Mobile will not occur. (Contact your network 
administrator or consultant for assistance with protocol changes or additions.) 

 Install Palm™ Desktop software for the Palm OS®-compatible device that will be used with 
the E-Z Mobile program. 

 Perform a HotSync® operation to verify connectivity and backup data on the handheld device. 

 Use the Add/Remove Programs utility in the Windows Control Panel to uninstall E-Z 
Conduit, E-Z Sync, or earlier versions of E-Z Mobile. 

 From the User Profile of the user who will synchronize data, on the Security Information 
tab, select E-Z Mobile - Palm from the PDA Options drop-down list. Access rights to the 
system level of CDS to change User Profile security options are required for this process. 
Refer to the Users and User Profiles topic in CDS WebHelp for setup procedures. 

 Ensure that the CDS E-Z Mobile - Palm option in Module Preferences is selected for the 
user who will synchronize data between CDS and E-Z Mobile for Palm. Refer to the 
subtopics of Getting Started in CDS for help with setting up Module Preferences. 

 Validate the Policy and Investment information in the database that will be used with the E-Z 
Mobile program. 
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Installing Mobilink Server & E-Z Mobile for Palm®  
1. Insert the CDS 6.0 CD into the computer’s CD-ROM drive.  
2. Cancel the Installation Wizard if it opens automatically and then open My Computer. 
3. Right-click on the CD drive and then select Explore. 
4. Double-click the CDS folder. 
5. From the CDS folder, double-click the E-Z Mobile Palm for CDS 6.0 folder to display its 

contents. 
6. From the Welcome dialog box, click the Next button to begin installation of E-Z Mobile 

Palm & MobiLink for CDS 6.0. 
7. From the Choose Destination Location dialog box, click the Next button to accept the default 

Destination Folder for installation. 
8. From the Enter Text dialog box, type in the name of the database that will be used for E-Z 

Mobile and then click the Next button to begin installation. 
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9. From the Install Tool dialog box, select the User name from the drop-down list and then click 

the Done button. 

 
10. Click the OK button to confirm that the file will be installed during the next HotSync. 
11. When prompted, perform a HotSync operation to install the E-Z Mobile program on the 

handheld device. The E-Z Mobile installation program will remain open during the HotSync 
operation. 

12. Click the Yes button when prompted to close the HotSync Manager and then click the Yes 
button again to confirm the choice. 

13. If applicable, the Database Upgrade Using SQL dialog box will display with all databases 
marked for upgrade listed. If this information is correct, click the OK button to continue. 
Note: CDS users may use the E-Z Mobile program to synchronize with only one database per 
license; however, the upgrade program only needs to run once for each database. If each CDS 
user will be synchronizing with a different database, then all databases can be processed at 
the same time. Click the DeSelect All button if there is more than one database selected on 
the Databases list, and then select only the database that will be used with the E-Z Mobile 
program. 

14. The database upgrade begins and when it is complete, click the OK button to continue. 
15. The E-Z Mobile installation is now complete. Click the Finish button to close the 

InstallShield wizard.  
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Starting the Mobilink Server 
1. Click Start, Programs, Startup, and then select EZMobile - Demo to start the MobiLink 

server. 

 
2. The Mobilink server starts and is now ready to synchronize the data between CDS and E-Z 

Mobile for Palm. 
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Enabling E-Z Mobile for Palm 
1. In CDS, select Modify Current User’s Profile from the expanded Database menu. 
2. Click the Security Information tab. 

 
3. In the Data Security Options section, select the E-Z Mobile – Palm option from the PDA 

Options drop-down list. 

Accessing E-Z Mobile on the Palm OS® Device 
Tap the Applications icon to display the applications list and then tap the E-Z Mobile icon to 
open the program. 

 

Client Data System® v6.0 – E-Z Mobile for Palm User Guide 
Revised: 11-23-05 

Page 5  



Running E-Z Mobile for the First Time 
When opening E-Z Mobile for the first time, the Security Information dialog box is displayed. 
The user will have the option to either enable or disable security for the device. Once security is 
enabled, the only way to remove it is to uninstall and reinstall the E-Z Mobile application. 

 
1. Click the Yes button to enable security and display the E-Z Mobile Login dialog box. 

Note: The password is required each time E-Z Mobile is accessed. The password must be at 
least 6 characters with at least one alpha and one numeric character. The password can be 
changed at any time by accessing the Security Password option from the main E-Z Mobile 
menu. 
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2. Enter the password and then tap the OK button to display the Sync Config screen. 

 
3. Enter the following information and then tap Done. 

• Type of Synchronization: Select the applicable Wireless Sync or HotSync option used 
to connect to the MobiLink server. 

• CDS User Name: User Name. 
• Host: Enter the IP address of the MobiLink server. 
• Port: Enter the Communication Port. 

Setting Up E-Z Mobile Synchronization Criteria 
1. With the MobiLink server running, log in to CDS.  
2. From the Tools menu, select the PDA Interface Setup… option to open the PDA Sync Setup 

Summary dialog box. 
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3. Delete any setup records that were used previously and then click the Add Record button to 
open the PDA Sync Setup Wizard. 

 
4. Choose the appropriate synchronization option and then click Next to open the Activity 

Record Selection dialog box.  
Note: If the Selected Contacts option is selected, the Set Selection dialog box displays. 
Specify the appropriate contact Set for synchronization. 

 
5. Select the Type of Activities to be downloaded from the corresponding drop-down list. 
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6. Specify a date range of future and past activities for synchronization and then click Next to 
display the SmartPad Record Selection dialog box. 

 
7. Specify the SmartPad Downloading Options and then click Next to open the Policy and 

Investment Selection dialog box.  
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8. Specify the Policy and Investment Options and then click Next to open the PDA Download 
Description dialog box.  

 
9. The PDA Download Description is a review of the information selected for synchronization. 

For the initial synchronization, the Full Sync option should be enabled. If all of the 
information is correct, click the Finish button to open the Save the PDA Download dialog 
box. 

  
10. Enter a Description and any optional Keywords and then click OK to return to the PDA Sync 

Setup list.  
11. With the PDA Sync Setup record selected, click the Run button to process the records. 
12. After the records have been processed, perform a HotSync operation. 
13. When the HotSync operation is complete, start the E-Z Mobile program on the handheld 

device.  
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Preparing Data for Synchronization 

1. From the PDA Sync Setup dialog box, tag the saved Sync record, click the Run button to 
populate the records from the database according to the specified criteria and then click OK. 

2. After the initial setup is complete, perform a HotSync® operation to synchronize the data 
with the E-Z Mobile database on the Palm OS® device. 

3. After the initial synchronization, double-click the saved sync criteria record to open the PDA 
Download Description dialog box.  

 
4. Modify the information as necessary and then click OK. Any data added or modified in E-Z 

Mobile on the PDA will automatically be added to CDS on the next synchronization. 

Using E-Z Mobile 
E-Z Mobile Tab 
Navigation begins from the E-Z Mobile tab; tap the E-Z Mobile tab to display a list of options. 
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Contacts 
Select Contact from the E-Z Mobile tab drop-down list to open the Find Contact dialog box. 
There are three ways to search for a Contact (Individual or Business) record: 
• Tap Find without entering any search criteria to display the global Contacts list. 

 
• Enter a portion of the business name or individual contact’s last name and then tap Find to 

display the Contacts tab matching the search criteria. 
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• Tap the first letter of the business name or individual contact’s last name to display the 
Contacts tab matching the search criteria. 

 

Creating a New Contact Record 
1. Select Contact from the E-Z Mobile tab drop-down list of options to open the Find Contact 

dialog box. 
2. Tap New to open the Record Type dialog box. 
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3. Select the Individual option and then tap Done to display the Details tab. 

  
4. Enter the contact information and then tap the Details, Phone, Address and E-Mail icons to 

enter the corresponding information. 
5. Tap Done to save the information and display the Contact View tab. 

 
3. Tap the Phone Dial icon to dial a number for this contact. 
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Contact Personal Dialog Box 
1. From the Contact View tab, tap the Details icon to open the Contact Personal dialog box. 

 
2. Enter the contact personal information and then tap Done to save the additions.  

Contact Phone List 
1. From the Contact View tab, tap the Phone icon to display the Phone List tab. 
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2. Tap New to open the Phone Details dialog box. 

 
3. Tap the Type drop-down arrow to specify the phone type. 
4. Enter the remaining phone information and then tap Done to save the additions.  
5. Tap the Phone Dial icon to dial the number. 

Contact Address List 
1. From the Contact View tab, tap the Address icon to display the Address List tab. 
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2. Tap New to open the Address Details dialog box. 

 
3. Tap the Type drop-down arrow to specify the address type. 
4. Enter the remaining address information and then tap Done to save the additions. 

Note: Both the Preferred Phone Number and Preferred Address are displayed on the Contact 
View tab of the Contact record. 

Contact E-mail List 
1. From the Contact View tab, tap the E-mail icon to display the E-mail/Web tab. 
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2. Tap New to open the E-mail/Web Address dialog box. 

 
3. Tap the Type drop-down arrow to specify the address type. 
4. Enter the remaining address information and then tap Done to save the additions. 

Note: The Preferred E-mail address will be displayed on the Contact View tab of the Contact 
record. 

Modifying a Contact Record 
1. From the Contact View tab, tap the Edit icon to open the Details tab. 
2. Modify the information as necessary and then tap Done to save the changes.  

Modifying a Contact’s Phone Number 
1. From the Contact View tab, tap the Phone icon to display the Phone List tab. 
2. Tap the number for modification to open the Phone Details dialog box. 
3. Modify the information as necessary and then tap Done to save the changes. 

Modifying a Contact’s Address 
1. From the Contact View tab, tap the Address icon to display the Address List tab. 
2. Tap the address for modification to open the Address Details dialog box. 
3. Modify the information as necessary and then tap Done to save the changes. 

Modifying a Contact’s E-mail/Web Address 
1. From the Contact View tab, tap the E-mail icon to display the E-mail/Web tab. 
2. Tap the address for modification to open the E-mail/Web Address dialog box. 
3. Modify the information as necessary and then tap Done to save the changes. 
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Deleting a Contact Record 
1. From the Contact View tab, tap the Edit icon to display the Details tab. 

 
2. Tap Delete to open the Delete Record dialog box. 

 
3. Tap OK to delete the selected record from the Palm device and the server.  

Note: Perform a HotSync™ operation to synchronize the data. 
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Deleting a Phone Record 
1. From the Contact View tab, tap the Phone icon to display the Phone List tab. 
2. Tap an existing Phone record to display the Phone Details dialog box. 

 
3. Tap Delete to open the Delete Record dialog box. 

 
4. Tap OK to delete the selected record from the Palm device and the server. 
5. Perform a HotSync™ operation to synchronize the data. 
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Deleting an Address Record 
1. From the Contact View tab, tap the Address icon to display the Address List tab. 
2. Tap an existing Address record to display the Address Details tab. 

 
3. Tap Delete to open the Delete Record dialog box. 

 
4. Tap OK to delete the selected record from the Palm device and the server. 
5. Perform a HotSync™ operation to synchronize the data. 
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Deleting an E-mail Record 
1. From the Contact View tab, tap the E-mail icon to display the E-mail/Web tab. 
2. Tap an existing E-mail/Web record to display the E-mail/Web Address tab. 

   
3. Tap Delete to open the Delete Record dialog box. 

 
4. Tap OK to delete the selected record from the Palm device and the server. 
5. Perform a HotSync™ operation to synchronize the data. 
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Creating a Business Contact Record 
1. Select Contact from the E-Z Mobile tab drop-down list of options to open the Find Contact 

dialog box. 
2. Tap New to open the Record Type dialog box. 

 
3. Select the Business option and then tap Done to display the Details tab. 

 
4. Enter the business information and then tap the Details, Phone, Address and E-mail icons to 

enter the corresponding information. 
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5. Tap Done to save the information and display the Contact View tab. 

 
Business Detail Dialog Box 
1. From the Contact View tab, tap the Details icon to open the Business Detail dialog box. 

 
2. Enter the business information and then tap Done to save the additions. 
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Business Phone List 
1. From the Contact View tab, tap the Phone icon to display the Phone List tab. 
2. Tap New to open the Phone Detail dialog box. 
3. Tap the Type drop-down arrow to specify the phone type. 
4. Enter the remaining phone information and then tap Done to save the additions. 

Business Address List 
1. From the Contact View tab, tap the Address icon to display the Address List tab. 
2. Tap New to open the Address Detail dialog box. 
3. Tap the Type drop-down arrow to specify the address type. 
4. Enter the remaining address information and then tap Done to save the additions. 

Business E-mail/Web List 
1. From the Contact View tab, tap the E-mail icon to display the E-mail/Web List tab. 
2. Tap New to open the E-mail/Web Address dialog box. 
3. Tap the Type drop-down arrow to specify the type. 
4. Enter the remaining address information and then tap Done to save the additions. 

Note: The Preferred Phone Number, Preferred E-mail and Preferred Address are displayed on 
the Contact View tab of the Business Contact record. 

Modifying a Business Record 
Modifying a Business record is identical to the steps required in modifying an Individual Contact 
record. Please refer to the Modifying a Contact Record section.  

Modifying a Business Phone Number 
Modifying a Business phone number is identical to the steps required in modifying a Contact 
phone number. Please refer to the Modifying a Contact’s Phone Number section. 

Modifying a Business Address 
1. From the Contact View tab, tap the Address icon to display the Address List tab. 
2. Tap the address for modification to open the Address Details dialog box.  
3. Modify the information as necessary and then tap Done to save the changes. 

Modifying a Business E-mail/Web Address 
1. From the Contact View tab, tap the E-mail icon to display the E-mail/Web tab. 
2. Tap the address for modification to open the E-mail/Web Address dialog box. 
3. Modify the information as necessary and then tap Done to save the changes. 

Deleting a Business Record 
1. From the Contact View tab, tap the Edit icon to display the Details tab. 
2. Tap Delete to open the Delete Record dialog box. 
3. Tap OK to delete the selected record from the Palm device and the server.  
4. Perform a HotSync™ operation to synchronize the data. 
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Deleting a Business Phone Record 
1. From the Contact View tab, tap the Phone icon to display the Phone Summary tab. 
2. Tap an existing Phone record to display the Details tab. 
3. Tap Delete to open the Delete Record dialog box. 
4. Tap OK to delete the selected record from the Palm device and the server. 

Deleting a Business Address 
1. From the Contact View tab, tap the Address icon to display the Address List tab. 
2. Tap an existing Address record to display the Address Details tab. 
3. Tap Delete to open the Delete Record dialog box. 
4. Tap OK to delete the selected record from the Palm device and the server. 

Deleting a Business E-mail/Web Address 
1. From the Contact View tab, tap the E-mail icon to display the E-mail/Web tab. 
2. Tap an existing E-mail record to display the E-mail/Web Address tab. 
3. Tap Delete to open the Delete Record dialog box. 
4. Tap OK to delete the selected record from the Palm device and the server. 

Calendar 
The Calendar views are: DayView, WeekView, MonthView and AgendaView. 

DayView 
Select Calendar from the E-Z Mobile tab drop-down list to open the DayView calendar. The 
DayView is used to display the activities for a specific day. Previous or future day activities can 
be displayed by tapping the left or right arrows. 
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WeekView 
The WeekView is used to view activities for a specific week. Previous or future week activities 
can be displayed by tapping the left or right arrows. 

  

MonthView 
The MonthView is used to display activities for a specific month. Previous or future month 
activities can be displayed by tapping the left or right arrows. 
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AgendaView 
The AgendaView is used to display a combination of timed and untimed activities for a specific 
day. Previous or future day activities can be displayed by tapping the left or right arrows. 

  

Adding an Activity from the Calendar 
1. From the DayView calendar, tap New to open the Activity Details tab. 
2. Enter the activity information and then tap Done to save the activity. 
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Activity Components 

• Phone: The Phone icon will display after adding an activity for a particular contact. This icon 
will display on top of the screen. Tap the Phone icon to display the phone list for this contact. 
From the phone list, tap the Phone Dial icon to dial the number. 

• Address: The Address icon will display after adding an activity for a particular contact. This 
icon will display on top of the screen (i.e., next to the Phone icon). Tap the Address icon to 
display the address list for this contact. 

• E-mail/Web: The E-mail/Web icon will display after adding an activity for a particular 
contact. This icon will display on top of the screen (i.e., next to the Address icon). Tap the E-
mail icon to display the E-mail/Web list for this contact. 

• Start/End: Tap the Start and End icon to choose the date for an activity. 
• Time: Tap the Time icon to specify the Start and End Time of an activity. 
• Contact: Tap the Contact icon to link a contact to the activity. 
• Location: Enter the Location for the activity.  
• Subject: Enter the Subject for the activity. 
• Type: Tap the Type drop-down arrow to display the activity type list. 
• Sub-Type: Tap the Sub-Type drop-down arrow to display the activity Sub-Type list. 
• Reason: Enter the Reason for the activity. If the reason takes up more than the space 

provided, tap the Reason icon to open the Details tab and display the complete entry.  
• Reminder: Select the Reminder option and then specify the amount of time before the 

activity to be reminded.  
• Private: Select this option to designate the activity as private.  
• Tracked: Select the Tracked option to enter an Appointment into the Activity Tracking 

cycle.  
• Priority: Tap the Priority Type drop-down arrow to specify the priority. 
• Status: Tap the Status drop-down arrow to specify the status. 
• Done: Tap Done to save the activity. 
• Cancel: Tap Cancel to ignore the changes. 
• Go to: Tap Go to to choose the date. 
• Delete: Tap Delete to delete the activity. 
• History: Tap History to view list of activity outcomes. 

Modifying an Activity from the Calendar 
1. Select Calendar from the E-Z Mobile tab drop-down list of options to open the DayView 

calendar.  
2. Tap the applicable activity to open the Activity Detail tab. 
3. Modify the information as necessary and then tap Done to save the changes.  
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Deleting an Activity from the Calendar 
1. Select Calendar from the E-Z Mobile tab drop-down list to open the DayView calendar. 
2. Tap the applicable activity to open the Activity Detail tab. 

 
3. Tap Delete to display the confirmation dialog box. 

  
4. Tap OK to delete the activity.  
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ToDo 
Select ToDo from the E-Z Mobile tab drop-down list to open the untimed activities list. 

 

Adding a ToDo 

1. Select ToDo from the E-Z Mobile tab drop-down list to open the untimed activities list. 
2. Tap New to open the To Do Detail tab. 
3. Enter the untimed activity information and then tap Done to save the activity. 
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Modifying a ToDo 
1. Select ToDo from the E-Z Mobile tab drop-down list to open the untimed activities list. 
2. Tap the applicable ToDo item to open the To Do Detail tab. 
3. Make the modifications as necessary and then tap Done to save the changes. 
Deleting a ToDo 
1. Select ToDo from the E-Z Mobile tab drop-down list to open the untimed activities list. 
2. Tap the applicable ToDo item to open the To Do Detail tab. 

 
3. Tap Delete to display the confirmation dialog box. 

   
4. Tap OK to delete the ToDo item.  
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Contact Menu 
From the Contact View, tap the Contact View tab to display the Modules drop-down list. 

 

SmartPad Menu 
From the SmartPad list, tap the SmartPad tab to display the Modules drop-down list. 
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Policy Menu 
From the Policy list, tap the Policies tab to display the Modules drop-down list. 

 

Investment Menu 

From the Investment list, tap the Investments tab to display the Modules drop-down list. 
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Activity Menu 
From the Activity Detail tab, tap the Detail tab to display the Modules drop-down list. 

  

Activity Log 
The Activity Log is a list of the activities linked to a particular contact that is used to display, add 
and modify activities. 

Adding a Timed Activity from the Activity Log 
1. From the Contact View, tap the Contact View tab to display the Modules drop-down list. 
2. Tap Activity Log to open the ActLog tab. 
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3. Tap New to open the Activity Detail tab. 

  
4. Enter the activity information and then tap Done to save the activity. 

Adding an Untimed Activity from the Activity Log 
1. From the Contact View, tap the Contact View tab to display the Modules drop-down list. 
2. Tap Activity Log to open the ActLog tab. 
3. Tap New to open the To Do Detail tab. 

 
4. Enter the activity information without entering a time and then tap Done to save the activity. 
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SmartPad 
E-Z Mobile is used to view, add and delete SmartPad records that are synchronized with the CDS 
database. Note that only those SmartPad entries that are added with the E-Z Mobile for Palm 
OS® that are not synchronized with CDS can be modified.  

Adding a SmartPad Note 
1. From the Contact View tab, tap Contact View and then select SmartPad from the drop-

down list to display the SmartPad tab. 

 
2. Tap New to display the Details tab. 

 
3. Enter the SmartPad note and then tap Done to save the additions.  
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Deleting a SmartPad Note 
1. From the Contact View tab, tap Contact View and then select SmartPad from the drop-

down list to display the SmartPad tab.  
2. Tap the SmartPad note for deletion to open the Details tab. 

 
3. Tap Delete to open the Delete Record dialog box. 

 
4. Tap OK to delete the selected record from the Palm device and the server.  
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Policy Menu 
E-Z Mobile is used to display the Policies, Policy Details, Interested Parties and Totals tabs on 
the Palm device.  
Note: Policy information cannot be added, modified or deleted from the Palm device. The 
information is read-only.  

Accessing Policy Information 
1. From the Contact View tab, tap Contact View and then select Policies from the drop-down 

list to display the Policies tab. 

 
2. Tap the policy to display the Policy Details tab. 
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3. Tap the IntPrty icon to display the Interested Parties tab. 

 
4. Tap Done and then tap Done again to return to the Policies tab. 
5. Tap the Totals icon to display the Totals tab. 
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Investments 
E-Z Mobile is used to display the Investments, Investment Details and Investment Totals tabs on 
the Palm device. 
Note: The Investment Details tab is intended to display investments with share and cost 
information. The Variable Annuity information is limited due to this restriction. The investment 
information is read-only.  

Accessing Investment Information 
1. From the Contact View tab, tap Contact View and then select Investments from the drop-

down list to display the Investments tab. 

 
2. Tap the investment to display the Investment Details tab. 
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3. Tap Done and then tap Totals to display the Investment Totals tab. 

  

Delete E-Z Mobile Data Using the Delete Data Option 
CDS 6.0 now features the ability to remove all E-Z Mobile data from the Palm device without 
having to reinstall the application. 
1. Select Delete Data from the E-Z Mobile tab drop-down list to open the E-Z Mobile dialog 

box. 
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2. Tap Yes to delete the E-Z Mobile data and then tap OK in the E-Z Mobile information dialog 
box. 

 
Note: Users must perform a full synchronization after deleting E-Z Mobile data.  

About E-Z Mobile 
1. Select About E-Z Mobile from the E-Z Mobile tab drop-down list to open the About E-Z 

Mobile tab. 
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2. Tap OK to close the About E-Z Mobile tab. 
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